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Hughes 9502 Upgrader User Guide (PC) Rev 3.7 (12-Dec-19)

This document explains how to use the Hughes Upgrader program for the 9502 User Terminal using a
PC.

1 Getting and Extracting the Upgrader

The Hughes Upgrader is a zip file that contains the binary software required for software upgrade of the
Hughes 9502 User Terminal (UT). Only the software appropriate at time of release is provided with the
upgrader (i.e., it may not include all the upgrade options detailed below).

If you downloaded the zip file version, the self-extracting exe file is within it; unzip that file first (you can
extract and then run the exe from the Desktop, or you can just run it directly from the zip file). Note:
examples below are from 5.9.6.1.
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Ta unzip all files in thiz self-extractor file to the Urzip
specified folder press the Unzip button, —

Fiun WinZip

Browse. Cloze

Iv Ovenarite files without prompting

About

Help

]

The destination directory contains the upgrader executable, as well as support files (including this
instruction file). If you used the default destination, the directory should look something like this:

v ) % 5961 - | X
Home Share View 9
&~ v > ThisPC » OS(C) » bgan-x > 596.1 v U | Search 5.9.6.1 ]

£.05(C) " Name - Date modified Type Size
~- USB Drive (£) @ 5.9 6.1 Announcement.pdf 12/11/2019 2:10 PM PDF File 84 KB
. USB Drive (E) & bganx 5.9 6_1bin 12/10/2019 12:10 PM VLC media file (.bin) 3,424 KB
1122 @ Hughes_9502_Upgrader_User_Instructions_PC_v3.7.pdf 12/11/2019 2:13 PM PDF File 304 KB
270 » Hughes_BGAN_Upgrader.exe 8/9/2019 1:43 PM Application 308 KB
. |=| image.txt 12/11/2019 3:17 PM Text Document 1KB

5518_usb_driver
)" Inmarsat.ico 8/2/2002 10:38 AM lcon 7KB
9201 %] mscomctl.ocx 7/25/2002 3:18 PM ActiveX control 1,038 KB
9202 [ msinet.ocx 5/21/2000 11:00 PM ActiveX control 114 KB
9211 [%] msvbvmé60.dll 7/25/2002 3:18 PM Application extension 1,376 KB
9350 %] mswinsck.ocx 7/25/2002 3:18 PM ActiveX control 106 KB
9450 v |2 README.tt 3/26/2019 3:30 PM Text Document 1KB
11 items =)
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2 Running the Upgrader

Before Running the Upgrader:

o

o

Connect to the 9502 UT via Ethernet or USB directly to the PC (if using USB, be sure the Hughes
USB Driver has been installed first). Note: Do not connect the PC to the UT through a router.

The UT antenna may or may not be connected during the upgrade (optional).
The SIM may or may not be inserted during the upgrade (optional).

Your PC’s network (Ethernet) interface to the UT should be set to “Obtain an IP Address
Automatically” (i.e., DHCP should be used by the UT to assign your PC an IP address); if your UT
is configured with its on-board DHCP server disabled, you will need to setup an appropriate static
address for your PC instead.

NOTE: If you have changed the IP address of your UT, you must enter the UT IP address in the
upgrader so it knows how to reach the UT. From the Tools menu, select the Configure Modem
Interface option and enter the UT IP address.

NOTE: Be aware that depending on your PC’s operating system (e.g. Windows 7), it may require
you to run the Upgrader with Administrator rights. If you see an error regarding a missing
component, such as MSWINSCK.OCX, MSCOMCTL.OCX, or similar, right-click on the

Hughes BGAN_Upgrader.exe file and select Run as administrator. Here is a sample error
dialog if this problem occurs:

Hughes BGAN Upgrader bt

[ “ | Component ‘'msinet.ood or one of its dependencies not
\ ' correctly registered: a file is missing or invalid

NOTE: You may also need to turn OFF your PC’s firewall settings in order to allow the Upgrader
to operate correctly. Also, be aware that various third-party programs may interfere with the
Upgrader’s functions because they act as a firewall.
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Upgrader Start-up Procedure:

Run the upgrader by clicking on Hughes_BGAN_Upgrader.exe. The following appears:

File Tools Help

» Hughes 9502 Terminal Upgrader

x|

IP Address: | 192.168.128.100 .
Software
Mew Software version:  Modem SW version: &I
| 5961 | 5953 [~ Upgrade SW
PIC Info
MNew PIC version: Modem PIC version:
| UNAVAILABLE | 1.1.21
Mew ATE version: Modem ATE wersion:
I UNAVAILABLE I LNENOWN
Mew HPA version: Modem HPA version:
| UNAVAILABLE | LNENOWN
Antenna Class: Antenna Class:
| UNAVAILABLE | LUNENOWN
Select the items above to Upgrade. Upgrade

| Dperation Successful. Release Info retrieved!

Figure 1: Sample Upgrader Screen while in Normal Mode

o This main Upgrader window shows the currently installed software versions on the UT, along with
the upgrades available with this Upgrader package.

o The Upgrader gives you the option to upgrade the HUGHES Application Software, and when
applicable, the PIC (Peripheral Interface Controller) Software. If any of these sections on the
Upgrader screen are dim, that means an upgrade to that component is not available/not possible
at this time (Note: the Antenna Software doesn’t apply to the 9502, so these options will always
be grayed out).

Upgrader Window Fields:

« |P Address field shows the local IP address of the UT. This is the address the upgrader uses
when communicating with the UT. A green circle indicates good Ethernet connectivity, and a red
circle indicates no connectivity. If you are using a custom UT IP address, this value can be
changed in the Tools menu explained below.
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Restore button will restore the UT to the prior installed software release, if available.

Upgrade button is used to perform the upgrade in conjunction with the Upgrade selections
(Software and/or PIC; note that the Antenna Info section is not applicable to the 9502 UT, and will
always be grayed out).

+ The status bar at the bottom of Upgrader window provides progress information during the
upgrade process.

X3

%

3 Performing Upgrade(s):
NOTE: Do not disrupt any upgrade while it is in progress and ensure the power supply is stable.

e To perform an upgrade, select from the available upgrade selections and click the Upgrade
button.
o Upgrades may be selected and performed individually or altogether. The Upgrader will
upgrade each selected component in sequence.
o Unavailable selections are grayed out, dependent on the released software upgrade(s)
provided with the Upgrader package.

e Once you click Upgrade, a Pop-up window appears, asking to confirm your choices (the selected
items to upgrade are listed):

Upgrader: user action required

Please Confirm your selections.
Do you want to proceed upgrading the following items 7

- Software

Yes No

o Click Yes (No cancels the selection)

¢ Note that if this is the first time you have run the Upgrader (or if you have changed the PC’s
firewall settings), the following may appear:

9 Windows Security Alert X

@ Windows Defender Firewall has blocked some features of this

app

Windows Defender Firewall has blocked some features of hughes_bgan_upgrader.exe on all
public and private networks.

)‘ Name:
: Publisher: Hughes Network Systems, LLC.
Path: C:\bgan-x\5.9.6. 1\hughes_bgan_upgrader.exe

Allow hughes_bgan_upgrader.exe to communicate on these networks:
[[JPrivate networks, such as my home or work network

[ Public networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing an app through a firewall?

&) Allow access Cancel

Be sure that the “Public” box is checked, then select Allow access to continue.
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e The section being upgraded will be then highlighted in green and the upgrade process will begin.
o The Status bar will show a series of progress messages as the upgrade proceeds.
o Please wait for the upgrade(s) to complete. Note that any one Upgrade operation (Software,
PIC, etc) can take up to 10 minutes to complete. Do not interrupt any upgrade since this may
leave the UT in an unknown state.

o Refer to the following figures for sample screens of an upgrade in progress.

» Hughes 9502 Terminal Upgrader

File Tools Help

x|

IPAddress: | 192.168.128.100 .
Software

Mew Software version:  Modem S'W version: —l
| 5961 | 5953

PIC Info

New PIC version: Modem PIC version:

| UNAVAILABLE 1.1.21 - Upgrade P
Antenna Info

MNew ATE version: Modem ATE version:

| UNAVAILABLE | UNKNOWN ™ Upaiade A

MNew HPA version: Modem HPA version:

| UNAVAILABLE | UNENOWMN

Antenna Class:

Antenna Class:

| UNAYVAILABLE

| UNKNOWN

Select the items above to Upgrade.

IU ploading Satelite |P Modem Binary to Teminal...

Figure 2: Normal Mode Upgrade in Progress
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e When the upgrade completes, the green highlight disappears. A few moments later, the New
Software version field should show the updated version. The Status bar should show Operation

Successful. Release Info retrieved.

)\) Hughes 9502 Terminal Upgrader X ‘
File Tools Help

IP Address: | 192.168.128.100 .

Software

New Software version:  Modem 5W version: ﬁl

| 5961 | 5961 [ Upgrade SW

PIC Info

New PIC version: Modem PIC version:

| UNAVAILABLE 1.1.21 r

New ATB version: Modem ATB version:

| UNAVAILABLE | UNKNOWN r

ME‘W HP& VEIEIon: M anern HPFA Yersion:

| UNAVAILABLE | UNEKNOWHN

Antenna Class: Antenna Class:

| UNAVAILABLE | UNKNOWN
Select the items above to Upqgrade. Upgrade
|U|:neration Successtul. Release Info retneved!

Figure 3: Successful Upgrade Example

e At this point, the upgrade has completed.
o If multiple upgrade selections have been made, the Upgrader will continue with the next
upgrade in the sequence.
e Check the Upgrader window and verify that the updated version matches the new version
supplied with the Upgrader.

Upgrader Menu Descriptions:

+» File drop-down menu:
o Upgrade Selections — same as Upgrade button
o Restore Software — same as Restore button
o Upgrade Antenna (Standalone) — (not applicable to the 9502)
o Upgrade PIC (Standalone) — same as Upgrade PIC checkbox
o Exit — exits the Upgrader
¢ Tools drop-down menu:
o Configure Modem Interface — allows you to enter the IP address of the UT. Default is
192.168.128.100
o Get Software Version — refreshes the Upgrader window and displays software versions
currently installed and available for upgrade from the Upgrader
o Reset Modem — reboots the UT
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+ Help drop-down menu:

o About Upgrader — displays Upgrader version
o Troubleshooting — displays Troubleshooting information

4 Troubleshooting:

Here is the Troubleshooting dialog that can be accessed from the Help menu — it describes how to force
the UT into Boot mode, in case of connectivity issues between the Upgrader and the UT. If you succeed
in bringing the UT up in Boot mode, do not use a custom IP (in the Configure Modem Interface menu),
and note that the Modem SW version field shown in the Upgrader will report BOOTROM:

i

Troubleshooting Instructions for Connectivity Issues K

If the Upgrader and BGAN Terminal are configured properly,
but there still is a connectivity issue, please follow the
procedures below to restore connectivity.

9502 Platform:
- Force the unit into BOOTROM mode by performing the
following:

1. Remove power to the terminal (disconnect power that
comes through the DC-cord).

2. With a small pin, press and hold the 'Boot ROM' button,
located under the SIM card cover.

3. While pressing the 'Boot ROM’ button, power on the
terminal.

4, Release the ‘Boot ROM' button after 15 seconds.
- At this point the terminal should be in BOOTROM mode.
- If connectivity still fails, repeat the procedure.
- Once the Upgrade is complete, the Terminal will return to
normal operation.

As an additional tip, if you have connectivity, but the following dialog box appears during use of the
Upgrader, it may mean your firewall settings did not allow access to Public networks; to correct, enable
for Public networks or completely disable the firewall on your computer and re-attempt the upgrade.

Upgrader: FAULT X

An unexpected FTP error occurred. Operation cancelled.

" Error Code: 12003 : 250 CWD command successful.
200 Type set to A,
200 PORT command successful.
425 Can't build data connection: 60.

Contact Hughes:

e-mail:

mobilesatellitesupport@hughes.com
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